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Learning from each-other…

Why are you here?

What line of business will QB help you with?



 Online

 PC Desktop

 MAC
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 Cloud-based accounting system
◦ Monthly Fee, subscription based

 Accessible anytime, anywhere, from any 
device

 Subscription-based accounting software
◦ Simple Start

◦ Essentials

◦ Plus

◦ Advanced

 Suitable for most business types

TIP! You can use the QuickBooks mobile app to 

perform many important QuickBooks activities!



◦ Self Employed: 1 User; Track income and expenses; capture and 
organize receipts; calculated estimated taxes; track mileage; 
$15/monthly/$180 annually

◦ Simple Start:  1 User; Track income and expenses; Mileage 
Tracking; Create Invoices and accept Payments; Tax Deductions; 
Run General Reports; Send Estimates; Track Sales and Sales Tax; 
Capture and Organize Receipts; Manage 1099 Contractors; 
$25/monthly/$300 annually (Payroll add $19/monthly+$2 per 
employee)

◦ Essential: 3 Users; Same as prior level+ Bill management; Enter 
Time; $50 monthly/$600 annually

◦ Plus:  5 Users; Same as prior level+ Track inventory; Track 
Project Profitability; $80/monthly/$960 annually (Payroll add 
$19/monthly+$2 per employee)

◦ Advanced: 5+ Users; Same as prior level plus Customized 
Access Levels; Batch Invoice and Expenses; Business Analyics and 
Insights; Custom Fields; Dedicated support and training; On-
Demand Training Videos; Automated Workflows; Restore 
Company Data; $180/monthly/$2,160 annually



 Desktop 2022

◦ QuickBooks Desktop for Windows is 
updating its product lineup.

◦ Subscription-based product lineup: For 2022 
versions, QB now is only selling Pro and 
Premier products as Pro Plus and Premier 
Plus subscriptions.

◦ 2021 is the last non-subscription version; 
Intuit no longer sells it, but it can be 
purchased from vendors who still have it 
($200 approx.)



 Desktop 2022 Subscriptions

◦ ProPlus:  Powerful capabilities and insights for 
desktop users; ($349.00 annually) (Does not
manage 1099 Contractors, Employee Timesheets, 
or Track Project Profitability)

◦ PremierePlus:  Provides for Industry specific 
features for a tailor-made experience (General 
business, Retail, Contractor; Manufacturing, Non-
profit; Service); and adds 1099 Contractor 
Management, Timesheets; and Project Profitability) 
($549.99 annually

◦ Enterprise:  End-to-end business management with 
advanced user permissions, capabilities, and more; 
$1,340/annually per user



 Mac
◦ Mac Plus Desktop for Mac 2022; $349.00 annually 

(one user); The Mac version is similar to the PC 
Desktop version, but there are missing features and 
interface differences; the limit is three users ($749 
annually)

◦ Similar to PC Desktop, Intuit is only offering a 
subscription-based Mac product

◦



 Examples of what QB Desktop does, that QB 
Online cannot do:
◦ Sales Orders

◦ Multiple ship-to addresses

◦ Making a copy of your file (practice sessions)

◦ Inventory assemblies



 I.   Introduction & Sales Part I (7/11)
 II.  Sales Part II (7/12)
 III. Expenses & Reports (7/13)



 Some of the basic principles of accounting 
 The accounting behind the scenes in 

QuickBooks 
 An overview of QuickBooks data files and 

types 
 Opening Portable Files
 How to restore backup files 
 Entering Transactions in QuickBooks 
 QuickBooks user interface features 



 To assess: 
◦ The financial position of the organization relative to 

its debts (liabilities)

◦ Its capabilities to satisfy those debts and continue 
operations (assets), and 

◦ The difference between liabilities and assets (net 
worth or equity)

 The Accounting Equation,

Assets = Liabilities + Equity



 Business transactions are recorded in several 
types of ledgers, called accounts

 A listing of every account is called the Chart 
of Accounts. 

 Each account has a type



 Primary five account types:
1. Asset

2. Liability

3. Equity

4. Income

5. Expense



 Total debits must always equal total credits
◦ Debits = Credits

 Double Entry Accounting
◦ Every transaction creates a debit in one or more 

accounts and a credit in one or more accounts.

 A debit might increase or decrease an 
account; the same is true of credits
◦ Depending on the type of account

◦ Debits are not always “bad” and credits are not 
always “good”



 Transactions are entered in forms 
◦ Invoices, Bills and Checks

 QuickBooks handles the debits and credits



QuickBooks has three primary types of files:

 Data files (extension  “.QBW”)

◦ To enter data or create reports 

 Backup files (extension  “.QBB”) 

◦ A condensed, stable version of the data file

◦ Restore into a .QBW file before using

 Portable files (extension “.QBM”)

◦ Very condensed

◦ To move your QuickBooks data to another 
computer

◦ Restore into a .QBW file before using



 Ensures safety of your data file

 Online backup safer than local

 To create a backup, select the File Menu and 
then choose Backup

 Scheduled backups



 Launch the QuickBooks program

 Previously opened data file will be opened 

 To open a different file, select the File menu 
and then select Open or Restore Company



Three main components of QuickBooks

 Forms 

 Lists 

 Registers



 There are various methods for entering 
information and transactions: 

◦Home Page
◦Centers
◦ Icon Bar



Menus

Home Page

Home Page

Icon Bar

Desktop QuickBooks User Interface 
Features





 Common tasks are shown as icons. 

 Five regions
◦ Customers

◦ Vendors

◦ Employees

◦ Company

◦ Banking



 Select activities

 Can be customized.



 Track company sales
 Set up customer records in the Customer 

Center
 Track income and expenses by Job
 Record Sales Receipts
 Use the Undeposited Funds account to track 

your cash receipts
 Record Invoices and Payments from 

customers
 Record bank deposits



 Sales Receipt:
◦ Cash customers 

 Invoice:
◦ Credit Customers 

 Both track detailed information





Business 
Transaction

Cash Customers 
(Pay by cash, check or credit card at time of 

sale)

Credit Customers 
(Pay on a date after the sale date)

QuickBooks 
Transaction

Accounting Entry
QuickBooks 
Transaction

Accounting Entry

Customer Estimate
(Optional)

Not Usually Used

Non-posting entry used to 
record estimates (bids) for 

customers or jobs.

Customer 
Sales Order 
(Optional)*

Not Usually Used
Non-posting entry used to 
record customer orders.

Recording a Sale

Increase (debit) 
Undeposited Funds, 

increase (credit) 
income account.

Increase (debit) Accounts 
Receivable, increase (credit) 

income account.

Receiving Money in 
Payment of an 

Invoice
No additional action is required on the sales form

Decrease (credit) Accounts 
Receivable, increase (debit) 

Undeposited Funds.

Depositing Money 
in the Bank

Increase (debit) bank
Account, decrease 

(credit) Undeposited 
Funds.

Decrease (credit) Undeposited 
Funds, increase (debit) bank

Account.



 Customer Center
◦ Open from the Icon 

bar.

 Setup Info





 Add customers

 Go to Sales or Invoicing from the left menu, 
then select Customer.

 Select New Customer.

 Complete the fields in the Customer 
Information window.
Note: You can enter additional information on 
the Note, Tax info, and Payment and billing 
tabs, if necessary. You can also add 
attachments.

 Select Save.





 Multiple jobs for each customer QuickBooks 
tracks jobs in addition to customers
◦ Helps track income and expenses 

◦ Help with reporting



 Create the customer job –
◦ “Branch Opening” for Tim Feng



 Use when 
customers 
pay at the 
time of the 
sale 

 Customers
menu > 
Enter Sales 
Receipts

 History Pane



 Create a new, on-the-fly customer, “Jerry Perez” 
and sell an item from inventory



 Temporary holding account 

 Tracks checks and credit card receipts 
before they are deposited

 Two choices:
1. Group with other Undeposited Funds (default)

2. Deposit to bank accounts

 Group with other Undeposited Funds is 
best
◦ Makes reconciliation of bank accounts easier



Invoice

Sales 

Receipt

Tracking Received Funds in QuickBooks

Undeposited Funds

Payment

Payments Grouped

Together on Deposits

Undeposited 

Funds 

Account

Skipping Undeposited Funds

Each Transaction=Separate Deposit

$

Bank Account

Option 2

Option 1
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Make Deposit

Preferred When More than 

One Payment on Each 

Bank Deposit

Preferred When Only One 

Payment on Each Bank 

Deposit

Undeposited Funds



 Use Invoices to 
record sales to 
your credit 
customers





 Receiving Payments 

 Handling Partial Payments 

 Where Do the Payments Go? 



 Select the 
Customers
menu, and then 
select Receive 
Payments





 Undeposited Funds
◦ Unless you turned off “Use Undeposited Funds as a 

default deposit to account” preference

 QuickBooks does not increase your bank 
balance when you receive payments

 To have payments show up in your bank 
account, you must Make Deposits.



 Two options
◦ Leave the invoice open 

◦ Write off the unpaid amount



 Depositing Checks and Cash 

 Holding Cash Back from Deposits 





 Fill in the bottom part of the deposit slip 
indicating the account to which you want to 
post the cash 



 Set up vendors in the Vendor list 

 Understand how to use classes in QuickBooks

 Use QuickBooks for job costing

 Enter expense transactions in several 
different ways

 Manage Accounts Payable transactions

 Void Checks



 Cash/writing a check to Vendors:
◦ Write check to appropriate expense accounts

◦ Don’t use Accounts Payable account 

 Credit Vendors:
◦ Track bills and bill payments 

◦ Use Accounts Payable account 





 Vendors 
include 
everyone from 
whom you 
purchase 
products or 
services





 Class Tracking 
allows you to:
◦ Separate your 

income and 
expenses by 
department, 
location, profit 
center, or any other 
meaningful 
breakdown of your 
business

◦ Create separate 
profit and loss 
reports for each 
class of the 
business



 Job Costing tracks expenses for each customer or 
job 

 Use the Customer:Job column to link each expense 
account or Item with the customer or job to which 
it applies

 Profit & Loss by Job report shows income and 
expenses separately for each job



 Pay vendors with check, credit card, 
electronic funds transfer, or cash 

 The three common situations are:
1. Manually write a check and record the 

transaction in an account register

2. Use the Write Checks window to write and print 
checks

3. Use the Enter Bills window to record Accounts 
Payable and then use the Pay Bills window to 
pay the bill 



1. Manually write a check and record the 
transaction in an account register  (Next Slide)



 Enter the transaction and press Record

 To apply your purchase to more than one account 
click the Splits button at the bottom left of the 
register



1. Manually write a check and record the 
transaction in an account register

2. Use the Write Checks window to write and print 
checks



 Select the Banking menu and then select 
Write Checks

 Use the Write Checks window to record your 
expenses: 
◦ If you’re tracking job costs or classes and are not 

using the Accounts Payable

◦ If you use Items to track purchases and you are not 
using the Accounts Payable



1. Manually write a check and record the 
transaction in an account register

2. Use the Write Checks window to write and print 
checks

3. Use the Enter Bills window to record Accounts 
Payable and then use the Pay Bills window to 
pay the bill 



 A bill tracks the 
amount owed 
and the details 
of purchase in 
Accounts 
Payable 

 You must pay it 
using the Pay
Bills window 





 Bills are tracked in Accounts Payable

 When you pay your bills using Pay Bills 
function, the balance in Accounts Payable is 
reduced 

 To use Pay Bills function:
◦ Select the Vendors menu and then select Pay Bills



Show 

Bills

Discounts 

& Credits

Payment 

Method

Amt to 

Pay



 Pay the bill for Ace Supply



 You can print checks either individually or all 
together in a batch:

 Verify printing with Print Checks -
Confirmation window.



 Retains a record of check and prevents gaps 
in check number sequence

 To void a check:
◦ Select check to be voided in Checking account 

register

◦ Select the Edit menu and then select Void Check

◦ Changes the amount to zero, enters “VOID” in the 
memo field, and marks the check cleared

138



 Vendor credits are recorded in the Enter
Bills window using the Credit radio button

 Discount window can also be used to record 
vendor credits, but has several 
disadvantages:
◦ Reference numbers or memos 
◦ Allocation of the credit to multiple accounts.
◦ Allocation to customers or jobs  
◦ The use of Items.

 Apply the credit to one of your unpaid bills 
for the vendor



 Describe several types of QuickBooks reports
 Customize the look of reports and filter the 

data on reports
 Memorize and group reports
 Process and print multiple reports in batches
 Use QuickZoom to see the “numbers behind 

the numbers” on reports
 Export reports to spreadsheets for further 

analysis



 Shows 
financial 
position, as 
defined by the 
balances in 
each of your 
asset, 
liabilities, and 
equity 
accounts on a 
given date



 Select the Reports menu, select Company & 
Financial, and then select Profit & Loss 
Standard

 Set the Dates fields From and To and Press 
TAB

 It summarizes the totals of all your Income 
and expense accounts showing the net 
income (or loss) for the period you specified 
in the Dates fields



 Use the Modify Report button to add or delete 
columns and change several other formats of 
the report 

 Use the Filters tab on the Modify Report 
window to narrow the contents of reports



 After you’ve modified a report, you can 
memorize the format and filtering so that 
you don’t have to perform all of the 
modification steps the next time you want 
to view the report

 Memorizing reports doesn’t memorize the 
data on the report, only the format, dates, 
and filtering

 With your report displayed, click Memorize
at the top of the report 



 Report Groups allows you to combine several 
reports into a group, so that you can later 
display and/or print the reports in the group 
as a batch 



 Select the Reports menu and then select 
Process Multiple Reports

 Select the group from the Select Memorized 
Reports From drop-down list

 If you don’t want to display or print all the 
reports in the group, click the checkmark 
(√) in the left column to remove it

 Click Display to show the reports on the 
window or click Print to print all the reports 



 Convenient feature that allows you to see the 
detail behind numbers on reports 

 Double click to see more detail.

QuickZoom 

magnifying 

glass



 Exporting to Excel to modify 
reports 

 After exporting, you can update 
the report with QuickBooks data 
from within Excel



 Case Study




